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PROTEL A K4

1 J L DL R
(1) ERC R EEHEFEANG T
a. BIEETN S e LT VO JEtE;
b A O EBCE OB S T AR BN grid JEME, IS LA
c. BIETCAERT pin J7 M) M), Z09E pin name %2 .
(2) JofFE I AT Ah: WA TE T EER AR OB e
(3) QUM TRESCAE M 4538 LRERRB /X N peb: 2B AR netlist B A ERE N glo
bal.
(4) MEH A RIS 2 3o 4R ok, T A ZAE A annotate.
2.PCB 4 WA 3% :
(1) MLt NODE %A #2:
a. JFUE R ICHE R T peb A R
b. JRELE A IO T peb R A RRAR— U B
c. JRHEETR O T peb FEH pin number AU EBE . 1 =M sch
HH pin number 4 eb,c, 1M pcb 4 1, 2, 3.
(2) FTERHT A REFT BN B — i 4t |
a. BIZE peb ZEIHAAE (E IR A
b. Z R BFEE T ok, peb BRI BRI I 45 o P o I Bl i)
s 46/ peb, RIEB AN ERFRIAFN
(3) DRC #4548 50 LA
RN ML B ATETE, HkE SO, &R CONNECTED COPPER 7K.
AN RO A WIN2000, 98085 bl 2 LIRS SCtE, Mo
) DDB (A%, Jak/b SC#F R SF R PROTEL BEAEHINLE . W RAER B A% 11, R
A AL

£ PCB Wil , ATZRIE S8 Mo dh e v (S S0, ] ARt (0 E % ARG
N, A PCB H, DIATE e i Re FRE fermr, 80P 8ma. TAFR
Ko PCBATEAT AL RUAATL S 2 J2 Ak, ALy B Aawik: H
AR AT H A AL, AE AT LAY, T LU A A0 2R FLB™ 141
LRREATANEL, B AN\ 5 ) 2 B AR QT A T, BRSO,
SN NN bR B, PIAHARE AR B AN L, SPAT RS B R G

HEAT L ATE =, BT AP AT R, AT T e B, BAhEL
T SIS PR S RO TR R A A gk, PR
MZGEM, RJFHHTRE AL, eIl LT AR A L AR LA,
R DURSE # EWOT CATRI 2. IFE BB A2, DAt B ARZICR

Xt H I A PCB B CSE B SUE LA AE N, 17, BRI T2 S5 A
LRIEIE, AMRPX o, LT HSLALEOR, e A GE R T Sl LA,
G VR 2 A Gl A (AT eI RE S A BT A, S i, S oh5EE, PCB
BB R AN 2R R R, EAURMA RS, EF) KT L
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MR ARLHOHS, A efdR It .
1 YR, Hhzkpgab B

BEALAE B PCB AR R A1 20 58 A ARG, (HER T, ek 1025 18 AN A 211
ST, SR N, A RE R R SRR . BT DU HL
HhZR (N AT 2 ZENEN A, T S Jr A A T DB B R ARBR EE, BARAIE
77 b R TR

XA ERHL 177 W BETE 1 CRE N DR UL AR ] (1 3t 2 b5 Ll 2 2 ) 5 P ™ 2
(RIS, O B AR i 57 1 AR -

AT N A s . Mgk AN R A .

SR TE YR ek I, Bl R L YRR TR, BTSRRI Mgk >
{55, MEESLEN: 02~03mm, &4 5% )% 15 0.05~0.07mm, L5
2k 1.2~2.5 mm

X EF LR T PCB ] 58 1R M 3 2R 4 e — /NPT, B RS i — At I ke At (R4
HEL B TFT HB AN BEIXAEAE )

R T A 0] J2 A T 2 D, 0 A L 34 g ) P b 7 48 5 b R B B4 A M
Mo Bk 20, B, s S H—2.

2 Hr v RO R (1) L b b 2

PAEAVFZ PCB NS L DI L B BN L D, 17 FR 80 L A
LR VR A B o DAL A A e I gl 7 225 18 AT T IR AR e ) i, R i)
2 ERIEE T

By AL AR vy, AL P A RBURR R B, R 5 R UL, R A 5 2R T g
B UK B L B A3 AF, R ZeoRk U, #E N PCB MAMNE R A4, Prid
WZBAE PCB N BEAT AL B A . A [ A, i A AR P9 P S Rt 512 s
ERDITRIENZ M EAMIE, FUEAE PCB AN IEREIIE AL (k).
By S BIMAT — fUE R, TR, R MER . tAT/E PCB _EAIE
(K1, X ARG KIE .

3 fEsdkfifedl () JZE

FE2 SR NI ATZRIN . TS S &2 AT C AR F Cahz, 2R
L IE IR M 2 g AP B N2 K AR R, AR AN I T, DA i gk A
JE, WIS Ol 2 BT, EEN SRR, HRA 2z,
DA g5 f i O B SR ) S8 2

4 RHIFR AR R I A 2

FERMIRAR A CRD v, B DGR I BE 55 FE 4, G S ) Ak B 5 2 AT
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LREMZLE, Bl AMEREM S, SO AR S T R O B, (E O R
PR AAE e RERE I ORERHZERIDRMNAG . @FSIEBER . T
LIS e T2 2, MUkt i, PR NABEE (heat shield) {f

PRAJEEL (Thermal), IXHFE, W AR AR FEIN DA TG 2SS4 7™ A R ) ] i
PER KA . 2RI Gl JZ BRI A HEAH [

5 ek ML REEIE

FEVFZ CAD RGUH, ARG R G RIE N . IR, T B ARAT Py
L ARV, B R R, I SRR A A IS TRl A e ) 5K
[l ABX G SIS L 7 i R S AT BRI 0 o i A7 L3 i e SO
U TR AR A g 2o e L e ATIALPT T RS o PR I i, it R /b
XHATIE A AR MR K o Bt AT A 1 B RS R GRS AT I AT

PRUETCEAEPIE 2 R AR B4 0.1 ] (2.54mm), BT DL RS 22 45 A S Atk — ikt o
90.1 9E~(2.54 mm)a/h T 0.1 9] RS E, e 0.05 3E~). 0.025 %), 0.0
2 Jin) A,

6 Wi E (DRC)

AL SEUR, A AR B AT 2R B A A S B P E RO, RN R
BT G F R 5 A5 5 BRI AL T2k, — e a A s JLAN I I

eytk, LhoufbIEat, LHTUESL, sofHRE S THEAL, Sl S BhEsL2m
IR AT A B, i AL A K

PR 2 A2 1) 6 B2 75 i, AU g 2 a2 15 i & (IR BB 2 75
PCB "2 it A fe kg n s iy s .

X OB A 5 et R I T B, W BER e, PRI Ee, SN S i
LA BHL T IT

PO FL B IR 7 LB B0 A AT 2% H O IR 26

JEINAE PCB HH I (B bs. vERR) Rl s 5 M.

Xt LA AR 2 AT B K

£ PCB LRI LZL? FURRER G4 LEMER, AR EGE,
AR R IRAE SRR b, DU s e i

2 SRR R R LR A AME D S 15 4/, LS = R R 97 e EE ARCA 2 2 3
R . WA

AR HAE T U BIE ] PADS 1 BV B v R A PowerPCB 1EAT IR BE 11
IR AT — S8 R, A TARA vt N SRt st e, il et A i
RV IEAT AT AN AT Ho A

2 Wik

PCB MBCTHRAE D A BRI A . R Judi AR, Mgk, fd, Ra,

i NS PR
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2.1 MR
W L AN PP 71, — P2 g A PowerLogic ) OLE PowerPCB Connection 1)

HE, ZE#E Send Netlist, N OLE IhfE, I LABE R PR+F IR ELE A PCB & 1)-—3%,
B ST RE. Mk 0E EHAE PowerPCB W54 3, 1E$% File->
Import, ¥ J5UH Az B 1) W e A A HEK

2.2 BN E

TR AR SR B B B Bt D204 PCBF BN B U S, AN AT R
B

ELEHN] T, RS RIS, Bt LRl R e i Ak PowerPCB T o a1 E
TR, RS SR B, ORUE SR BEERT PCB 3. B T kR A
JEE AL, AU T %, Thl Pad Stacks, w7 B SO HEIL FLAT RN
R T — MR L, — 2 E Layer 25,

=7

V=

PCB Bevb i), 2 . o fLisEE . CAM %t W s C & VE g Ja s ek, 4
A Default.stp, PRIAS KLU, TG ISERR GO, 8 FEYE X 26 1 Hh 2y
Mogs R R A2, IR e s PO . AR RN W B A LUS . {E Po
werLogic 11, i OLE PowerPCB Connection ff] Rules From PCB Ijfg, HEHr
JR PR e R A, DR UE R PCB . R — 2

2.3 Jian AR )R

LN LG, BT e a2 e TAEX & s, Eae &, 21T
VERR R IX L OB o FF 5 $2 Lo R JBCREST, BIOC A J5 . PowerPCB
AL TR, FLAARM AR 2.3.1 FLA)R

1. 1 H ERRIAR ) 25 k) Ro~f i A (Board Outline) o

2. B ouas o (Disperse Components), JCas S HESAENIL H FE FH

3. IR A AN BERe, TREIBGALLN, F R R RO
23.2 HEMA)R

PowerPCB #&4i T H A1 Ja Al B 3h i Jy B aAT Jmy,  AERR 2 B devt ki, BOR
FPANREIAR, AHERFALTH] . 2.3.3 1R

a. A A E R NS R UEAT A A %, B hde P m REmiEs:, A%
LR R MR IAE— &

B ARSI, R B

C ERHEA RS S vee

. JBCE AN R LU R, ANBRE AR

. A AL Array F1 Union DhRE, @A Rl IR 30%

2.4 Atk

o

o o o
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ATy A R, T TATLA A3 4k . PowerPCB Sl T T AT Th fig
oromk, A AEhHEST . LB E (DRC), Hahfik i Specctra (11417
2| AT, WHIXIMOIER A, P ERET L —a3—T 1.

2.4.1 F AL

1. HAEUAMZRT, JCHF LA SeE ML, thanm i g, = iyRas, xu
WA A LR B L 2. ZRlm)EE . BRMCSE AR R K I Ah— el ik A,
1 BGA,

H A AR MEAT A FN, T AL

2. AL LlE, WEHT TATLX PCB L Lt 3,

242 AL

FTALE NG, FITHMERAZL B MK A, &L Tools->SPECC
TRA JA 3l Specctra s 4% 11, WELF DO A, 4% Continue HtJH3) T Spe
cetra ATZ s HANAM Lk, 4505 WERATIE A 100%, B2 5t r] LASEAT T T B A
2T WIRAR] 100%, oW R BT DATZAT )8, 75 2R A R el T LAk,
AR ATIE A 1.

2.43 VERE I

a. FEYEZR AN 2k ) Ik

b, EMHARES VCC HEGER

c. WHE Specctra [f] DO SCAFI, & 5EHN N Protect all wires f7%, PRI F LA
LA A B A B A AT

d. WRHRAHIEZ, Mizkiz/z e X0 Split/mixed Plane, 7EA7 2k 2 Fiit )
H, fisegk J5, {1 Pour Manager 1) Plane Connect #1775 4fi

e. WP AT B S AT IV B A R T 3, kSR Filter S04 Pins, &SI
B, BUUEYE, 7 Thermal EIHTTT 2

f. FEh LN DRC EH4THF, HZ)&AZk (Dynamic Route)

2.5 ffE

R (5 H A A EE (Clearance) 1EFME (Connectivity). iR (High Spee
d) MIHYEZE (Plane), XLEI5H AJ LLik+€ Tools->Verify Design #4T. WK E
TR, gk A, AT DAk X T, A A A R, s A SR R A
2.

VYL
V=

U AT DU, B WA S B I Outline 3820 ICAE T ARAEAN, A A ]
PRI WA AN Sad B LA L 5, AREEE R A A — IR

26 H&

HEMRYE “PCB K &rk”, WARGFER N, e . 2%, Mih., Ea. o
LR E; EBEESEESAA RGN, HYE, HLMEREL, mbn e
MHEL S BEll, LA EIRANERSE . EAAGH, Wil & 2S5 Am R A
ik, AM2)E, EEHEMBIE IS,

2.7 b
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PCB % ih ] LU H 24T ML a2 Se k. $TERHLAT LA PCB 40 J24TEN, {#
TR EME EFRA; e ST 5K, A= B . Sase ST
T EE, SCRBNIK IR BTN, T R E 0 B A 2 SO i R
a. BRI EAAAL)E (BRTZE. K2, PRAZLE). B¥EZE (BF ve
CJZFI GND JZ). ZE)2 (GFTZLE. JRJZ22E0)., FH)ZE CERRTIZ G
FRJZBHAL), Sy AME B A A LS/ (NC Drill)

b. R HEIEE R E A Split/Mixed, JEA7E Add Document % -1 f#) Document i
#£ Routing, Ff HAG G SO 217, #ER PCB B H Pour Manager (1] P
lane Connect HEAT#H; IR K E N CAM Plane, WILFE Plane, fEi%E Layer
TR, 2540 Layer25 N b, 7 Layer25 )2 1%k$#¢ Pads Fll Viasc. {EB#4 W HE
% 11 (3% Device Setup), #f Aperture FI{E XA 199

d. WA EZEN Layer I, K Board Outline % I

e. WHZEZ Layer B, ANEEF Part Type, EFHTZE UR)Z) FLZHIZK

Outline. Text. Line

f. WEFIE N Layer I, EF fLRR I L EA B , AL fLRR A BLAE,
LR AR DL E

g AL, A8 PowerPCB UGS R E, ANEA/EAFME) h. irats:
AT BUS, H CAM350 T FF4TER, it fE &5l “PCB fufrk”
for A

AL (via) 2% 2 PCB E B A2 —, BifLII 3 s i PCB HiliR 2% H
1] 30%%2 40%. iUk, PCB LfRE—ANFLE T LAFR 2 ik fL. MAER I
Fo WAL A S — R RS Z R A% S RS R ] e 5l e
o RN TERIFE LR, KB fL—M X =2, WEFL(blind via).
fL(buried via)F1ill fL(through via). & fLALT ERIZE AR 1 T2 R 23610, H
TR, HTREZLE TN EEsriEs:, FLrR s AT —e
LR (LAY MEALR TN T EO R 28 BR AR N J2 AL, B A2 e 21 26 B AR (1)
K. FIRPIRFLEAL TR N 2, 2 FT R B L T 256, et L
FE RS R AT IR 2 S LN o 55 =PRR B AL, XA L Z e a2 %
B, BT TSI N O By To i e e AL B T IE ALY T8 B 5 T8k
I, AR, T LA RS 2 R L B AR A &, AN S APt fL. DA
FruaritfL, AR UL R, WENIESLHEIE.

MBI R, — N AL BB A a8, — 2 S FL (drill hol
e) , SEENALE AR X, UL R IX P ER R ST RN e T AL RN
RS, TEmid

SR LI PCB TN, il Soe A B fLll B, KRR BT U A 2
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(PIAT L2 0], dbah, shFLEUN, 8 G105 A R AN, BiEA T Rl k.
(EFLRSE R S Rk T A g3 n, g ELack L RS AN mT TS BRI 9]
B2 BB LAl RS (plating) 55 T 2 HEORBIRRS]: fLBN, BifLTEAE 21
I AL, Bk O 25 PO B HE ALV SR B L E AR 6 fi5 i, whoc
EARUEFLEEREIY SJBEA . b, IAEIE R —3k 6 )2 PCB MR IR GHFLIRED
9 50Mil Ze 47, FirLh PCB | K et it 15 fL B AR 5/ K AEIA 2 8Mil.,

. LI 25 A HL 2

REALA S AP fEE R A AR F 2, S S it LA L Z BRI B fLE AR N D2,
LIRS E RN D1L,PCB AR WS TARGEM A HCh ¢ I FLI 25 A2
HRANERLT

C=1.41 ¢ TD1/(D2-D1)

ik FLIR 25 A HL A o 2 FL S ) R e S TR 5 I BT RIS TR], PRAC T g
(R RE o 2800k d, ST — RS2 S0Mil ) PCB AR, i BAE T 4%k 10Mil,
PR EAR O 20Mil 13k fL, FRA S A A DX 1 EE 2 R 32MIL I FRATT AT DUE ik F i
(1928 AU ek LI B AR R A KB : C=1.41x4.4x0.050x%0.020/(0.032-0.020)=
0.517pF, IX{& 7 B2 5 R BTN A) AR 4 524 T10-90=2.2C(Z0/2)=2.2x0.517x(5
5/2)=31.28ps o« MIXLEEE P LUE th, R AN FLIG & A i 5 L 1) FTHE3R
IR A AR B, AR A0 BB 2 2 Al Hk FLEEAT JZ Rl Ul e, deit&ik
SETHE BN,

=. LA A

[FIAE, S FLAT AL R 2E R I [R]IN A7 A 2 2 g, A e TR L ) BE T
LU Ay AR LA R G FAEAE K T o A2 A R o B 3 28 FR I L 2 1 59

TS — ANk FLUT AR B A HLJEK

L=5.08h[In(4h/d)+1]

Horp L4t fLA R, hoR i LK, d 2PoaifLr B, MU LG
ok FLI B AR HLR RS M /), 6T R i) e K 2 e FL G B o AT9ARR A |
5, a RIS LA HLECh . 1=5.08x0.050[In(4x0.050/0.010)+1]=1.015
nH . WHRESH BT E Ins, BALERBHSTR/NA: XL= 1 L/T10-90=3.
19Q , XFERIBHPUAET B IR A X C AN RERE B 208, R 2R, 52
AT 1 v A2 T 2 1 B 5 B e P AN ik AL, Xk LI B A LR S A
.

Ig. =ik PCB i fL ik i

T3 E ey i FL 2 AR M, FRATTRT LAUE R, FEmiE PCB i, B
BRI

FUAEAE 2 20 H K I U SRAR R I I RN, o R T kNI L IR 3 A2 R0y SR 1)
ARz, ZEBerhHa] UL B AL 2

1. MATUE 5 W T %S, EREAE RS LR/ BBk 6-10
JZIW
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AR PCB %315k Uk, B 10/20Mil CEEFLAGRED) B FL L, *FT—Lmas
BERI/NRSFIR 7, W aT LR AE ] 8/18Mil it L. HATEE RS, BT
FEEANRSFREFL T o 5T F g sl 2 1 3 FL 00wy A5 RE A F B R R <), BAZ)N
BELPT .
2. RS AN A AT PAAS Y, AR PCB AR RN i FL T
Ty
B
3. PCB M _EHIfE S EL R EAT)ZE, Wil vl R EA AL R L.
4. FEL YSURT M P A5 BRIl A T ek L, LA B 22 8] ) 5 2 e bk ey, IR Ay e
RS
SRR R R A ) 5 BT RER, LA/ BEPT.
5. RS E R FLRHT BCE — s i AL, DA NS S R AT i R B
H
B0 PIAE PCB R b K E — Y2 et L.
MR, AEVOHIE T ERIE 248 . AT DTS i USRS e A7 2 S P A A O
SRS
I, Pt my LUK 388 2 R A5 el /N 8 et o R e o L2 B AR K IR I
T, WTRES S EHEMI )2 T — AN B W 0] 3 i Wikl A W dXRE 1 1n) @R T R Bk
FLEIAT B, FoAT 1k o] DL & ok FLAE 2 A 2 R s R ST

): M WORD A2 I RIAF S, M AASBERS#E PROTEL HIE % o
5 35 MRS LE SCH MBS i /2 7F PCB #5578 PCB RIS 2 A5 — Seh ik A 45 AN fig
S, IR A R AR B

i]: net #4155 port [A]44, peb H ] f7i% %

% 5. v[LLPROTEL nJ BLZ My XA e 4%, AR A e 2 IR LA port-port 1,
TRk ki BT LURAHIAIG NET 44, EA1AN 2 PR N 4% 44 0 — A I 04 1 AR AN B4
JH F R 11, R kg F06 A2 4 Ji ).

;-3 i) /F PROTEL99SE 15 A\ PADS i, M i@tk 7
5 IXZ SRR Ry PR AR A RN R RROAS 22 T0) P 2 s i, JES iSe—F T AR 28 ik
CI g

)« 15 ) A U : A (] 3 o A power logic st BE #4461k protel JiT, £E protel
OB TR SN, RE—B0, EAAIMSE, EAR SR REME? !
B e, WTUM—AN R, IR EH A

) s 5 AR ) S 2
e BHE— ROVAXAE VRN 24T B 2 % LA 32 LAYOUT 3 RN IR

[7]: 1% "] Potel DXP £F H &A% Jai /7 A TG etk 2 5 N 35 25 ) 6 75 MR 4 Jo 2R 1 1 A
Jai B shHEFF?
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2. PCB i i 5 R B AN R € N AR SRR R, HUttk, Potel DXP 71 H3)
i JRS I AN S M T 8 B AT =) 1 shHETT « ORI 1~ B 287 1 oo E 2, T LA B PCB
A JR A JEUEE P PR )

W) : 1 5 T SEEEPE S BT IR TR AT A b 7 ) 3K
2. Protel AFACA VELN 15 5 5E B M 0t

s DG TAHA, SCPFMEAK? A7 )5 ik?
e SRR DB R . (HAURSEIE R, WM B B AR

). A A IMEAL ISR B AT 5 T AR I ?
2. ALl

[i]: PROTEL 1)j ELA] BEAT R BEMERAE, G0 VRGN a] LLAS S 47 (1) 45
& : PROTEL /i L5842 Spice B, nf LLNARAT) R Ab3RAS fe %% Spice Y,
HEATH . PROTEL W27k, HA LM B A, @A iy,

7] : 99SE HH WM AV T, WIRAL G % /0 TADZRIG ! 3-28 14:17:0 {4
ST AR
5 AR DU I RRAS AN

W WA EE—ANFLR 2%4MM  AME A 6MM [R5 352
5 AENUBRZARETT LT o 5 IR 5 72 T8 H AR R

s FRANIE, EEEW%FWH%%ﬁﬁﬂ%W%F ¥, WML, ks
W) 28 2 Bt Y A ) R
2. FH from-to %ﬁiﬁiﬂ% E¥z

o) : SRR E N 99se IR BUARAEL A ul IR 2 TECE IE SR 1 T iEAN T HL,
LB AR WIAAE R BRI I AN BEE T ?

S ARSI, n] DU R AR A 1 I 58 BT E AR R IR . £E3E4T PCB
BT I BT R 4 e k. JATRT LA Protel 28wl 1L

) e dqn] 4 B SR A AT ) st BRI ZE R peb 2R
5. IBPRAT LY WWW.PROTEL.COM F#;

) WA A N$E TAER A LS b2 OB I ST, & K IRIE LS 7 1
A4 N5 W 7 AT ARG T — N MBS A B i B TN
Foetfmeh T g aeil—1

2. FZH PROTEL99SE $e (IR E v S Mk, AR RS0 (B30 i
BRooE, (R E —ANootE) K2z eI ER B E % IMIL, FEH, SR G % s)mE i,
PP RE S EREN, M% NO,
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vl s 1 SRR B IS, ] oA S LR 2
e RN, AR KR A Thae, WU A, =R, HHwSE. el
I BEZIHEBO D Re,  — R RCE A 5 1

1] : protel99se6 HENAL A, (LML S MIFHL 2 L2 ELIREL:, BB
B, AR =MIBHGEL, WA KRR T TBIE, IR0 AU Ak % ?
e SEWEICIERI, R,

i): H] PROTEL M, KEBSE, KIASCAAEBARE K GEMD, FHEHS
AN THZ . AEA? 2 A7 AN S8 5 2

e SO A Ol PROTEL R4 2 28 25 41 i) Jgt DR 3 e iy, DR R B
ANBENE ] PADS HL “HEK” Thfie, (HEAERIEFAL, Bl LLE SR “ 2E4 7
FGCER, ARH] WINZIP e R gAR /N e AR SO RS

) 35 ) AE[R] 23 b, BRI E AR ER > 58 BEA R, 1y H A S50 ?
!
e AREEBNTERG R LU G4 S o

liaohm [v]: UK — B[] AT JLAE ) ?
fanglinl63 5. AW AT )L 1R . EDA J2 T A

). protel LAY HDL J2& Y& ) VHDL
%3 : Protel PLD A&, Protel FPGA 4.

) AN PR, A I ORI AR i, AR
K IS R ARAE AN IN v T P By B LA, (R B R g s a) i 5 A
Byt Jy e ] UMEAN AN

) s AP AN ] DAECAN IS RAR A2 5T A 2 I AT 1R 26 DR JsOR ) B ke s
L ] DB AR RR IR AL o FE BN AT e I A (1 AN RE AR DR R ISR A A 2450

i # Protel RAFFIREIS, RAAEAEIFH EDA SRR
52: BB

] : Protel DXP f¥] H a4 2SR & 15 n] LLA 2 it ACCEL 7K1 ?
5 A2 AR

1] protel ] pld DIBELF A SCRFALAT M) HDL 1 5 2
%2: Protel PLD ff /1] Cupl &5, tH2&—Fh HDL iE5. F—RARLEBEH
VHDL & S5

[]: PCB HLIAI1) 3D DhEXS A o] 25k ?
5. T 30FF OpenGL.
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R e S o S /B e A O 2 1 7 o N e 97 ) e LK L EN P el
53 eI E R, AR5 T BMP2PCB R4 i ek, SRS FE ok
{HARIY) PCB KSR 04545 0.2MM LA . BMP2PCB F&JFH7E 211C TR, R
LR AR VP AT R s RERGED

). ELEZH PCB AR, Qi) AN LB 2 i 2% 44 7
& AE Net GiHXTIHEH B E

e B AL R TR B R S bR, ) allego —FE
S R AT, DA R R LGS R LR

). HEMLINBUEIREA L], REATI AT, AFIEEANH?
e BOH I RRAS T IS ) il

s Q] S22 A et g R B AR e
B I PSR 1ot

W M p 99 MUINA D FRALHL, 2 A4 SR A2
5. N2 D IS

"] : powpcb [ A E4E ] PROTEL ]+ ?
2. S — PCB U/, RS H T ATRER R,

). /EFEM PROTEL99 H 5 A\ GERBER X {4
2. Protel pcb HEESF A H K Gerber,ifii Protel ) CAM 1] PLS A e %20
Gerber.

) : AT EAT LY PCB L £k (1 4 £ 4% 7 o L o fH 2 2%
e MBS R gt ERULARCAT. B HoR AL 2 38 NOFT 2R 56 .

TR G 1o G e I GEN 5 E SRS N U VS WANG A S Y S A8 R R VA UR 5 e
B Gige, AT RgH

) e AR AE S B RS HL e e A RO A RSS2
B AEPEP BRSBTS, £ PCB AR Lt n]
Lz, Cefeocfbig itk b o).

1) : BEATAEM PCB N TOAFAT 5 R SR L8 B 50 n EAE el i 2
e AeoufrE b ZEOCIUE, SUnTHE PCB Wittt I HASEmE+H
Jutf

o): SRR HLZL, G S, IR R P L T Y T
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